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INTRODUCTION

Congratulations on your purchase of the Audio / Video Automation System Processor.
Your complete satisfaction is very important to us.

Gefen

Gefen delivers innovative, progressive computer and electronics add-on solutions that
harness integration, extension, distribution and conversion technologies. Gefen'’s reliable,
plug-and-play products supplement cross-platform computer systems, professional audio/
video environments and HDTV systems of all sizes with hard-working solutions that are
easy to implement and simple to operate.

The Gefen Audio/Video Automation System Processor

Gefen delivers innovative, progressive computer and electronics add-on solutions that har-
ness integration, extension, distr bution and conversion technologies. Gefen’s reliable, plug-
and-play products supplement cross-platform computer systems, professional audio/video
environments and HDTV systems of all sizes with hard-working solutions that are easy to
implement and simple to operate. The Gefen Audio/Video Automation System Processor

Gefen introduces its new Audio / Video Automation System Processor- a new way to
control your home. This new system works over your home network and in concert with the
Gefen PACS (Professional Automation Control System) and Mini-PACS hardware to control
all key audio/video features in a home or commercial environment, as well as automation
of lighting, temperature, window shades and more. In a typical home entertainment sce-
nario, users have multiple sources, such as Blu-ray players, Apple TV®, iTunes®, satellite
or cable set-top boxes, and more, all connected in a system integrated with one or more
displays in one or more rooms.

What makes the GAVA System unique, is its ability to control applications on a home or
business network rather than on a stand-alone controller with dedicated cabling. This
makes it ideal for retrofit or distributed systems. Another unique GAVA feature is its ability
to connect over your network with Apple TV (series 2) and computers (Mac or PC) run-
ning iTunes, with display of Cover Art and song metadata. The GAVA system is specifically
designed to allow control through an interface that works with all smartphones and tablets
today. It is optimized for the iPad®, iPod touch®, iPhone®, Android™ phones, and other
smartphones, as well as Android™ and other tablets. GAVA is designed for quick instal-
lation- only a single cable is needed, and the Configuration Wizard allows a system to be
installed and configured in less than half an hour!

How It Works

Simply connect all your IR and RS-232-controlled equipment to one or more Gefen PACS
Controllers. Then connect the GAVA and PACS to your network. Make sure your mobile
devices are configured for WiFi access to your network. Open a Web browser on your

PC or Mac to configure your GAVA system. Just select your components from GAVA's
library, and configure connections from drop-down menus. Open your mobile device’s Web
browser and point it to the GAVA Web page and you're ready to go. On iOS devices, click
the “Add to Home Screen” button to create a GAVA icon for immediate one-touch access to
your system.
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Important Operating Notes

READ THESE NOTES BEFORE INSTALLING OR OPERATING
THE PROFESSIONAL AUTOMATION CONTROL SYSTEM

The GAVA is shipped with a static IP address of 192.168.1.82. This address may need
to be changed before the GAVA will work on the Local Area Network. See page 10 for
instructions on setting the GAVA to a new IP address.

Most systems will only need one GAVA controller. If your network will contain multiple
GAVA units, each one must have a unique IP address before it is connected to the
network. Install one GAVA at a time, and change its IP address before connecting
another GAVA to the network.

The GAVA acts as a bridge between your controller (e.g. PACS, Mini PACS) that is
sending the RS-232 commands over your network, and the actual RS-232 port on the
device that is being controlled.

Check www.gefen.com/GAVA for the latest Web browser compatibility list.

Before updating the GAVA software, it is recommended to clear the Web browser’s
cache.

If an “App” Home link gets deleted, the link can be restored by typing in the IP address
of the GAVA in the device’s Web browser.
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Features
. Integrated HTMLS5 Web Server supports any smartphone or Web browser.
. Intuitive Graphical User Interface (GUI).

. Local low-power Linux processor contains system controllers, device interface codes,
and a Web server.

. Easy Wizard setup with no programming required.
. Simple configuration interface.
. Directly controls Gefen IP-controlled devices and other selected IP devices.

. Offers control (through EXT-PACS) of any IR and RS-232-controlled devices, and
trigger contacts.

. May be powered over Ethernet cable with optional power adapter.
. Fan-less, silent, low-power processor may be placed anywhere.
. Full two-way control of RS-232 and IP devices.

. 2-way IP interface with Apple TV® and computers running iTunes®
(PC or Mac).

. One or more PACS gateways may be located anywhere on the Network.
. Offers Lutron® interface for lighting, appliance control, and more.
. Other lighting and appliance interfaces (Z-Wave, etc.) coming soon.

. A second GAVA processor may be installed to provide system redundancy. Normally,
only one GAVA processor is required for any size system.

. Supports UPnP IP devices.

Package Includes

(1) Audio/Video Automation System Processor
(1) 3 ft. CAT-5 cable

(1) 12V DC power supply

(1) AC power cord

(1) Quick-Start Guide
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Panel Descriptions

LAN
Connect the GAVA to a network.

12vDC
Connect the included power supply to this power receptacle.

RS-232
This port can be used to control a device via bidirectional RS-232 serial control.

uUsB
The USB ports are used for firmware upgrades and some device interfaces.

Controller Indicator

This LED indicator flashes bright green when the GAVA is operating properly and
when the VPN connection is enabled. When the VPN is enabled, this indicator flashes
approximately twice every few seconds. Otherwise, it flashes about once per second.

Program Indicator

This LED indicator glows bright green when the “daemon” (the invis ble portion of the
program that runs in the background and controls the system operation) is running
properly. The HTML5 Server is the “vis ble” portion of the program that provides the
Graphical User Interface (GUI).

Copy Indicator
This LED indicator glows bright green when the program is being updated and data is
being copied to the internal memory from a USB port.
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Connections

Connect an Ethernet cable between the GAVA and the network.
Connect the included 12V DC power supply to the power receptacle on the GAVA.

Connect the included AC power cord from the power supply to an available electrical
outlet.

Wiring Diagram for the GAVA

HDMI
Smarfphone RS-232

Toblet & ETHERNET
) = IR —

GTB MINI PACS 12V/GND TRIGGERS
AuDIO

Powered
Screen

”~

Wireless Access Point

Wec or

-

Projector

Network

-

=
Blu ray Player ?

EXT PACS
AN Receiver
B (GTV AUDDEC N|

EXT GAVA

PC or MAC
(GAVA Control System]

(For Configura ion
and iTunes)

v
\\\ \\ Lighting Controller

(Z Wave or Lutron)

Set Top Box

Apple TV.2 Ua

Dimmers

NOTE: It is highly recommended that the GAVA be connected to a UPS
(Uninterruptable Power Supply) for reliable system operation. In the condition
that power is interrupted, the GAVA should re-start without user intervention.
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Installing GAVA - Setting up the Network
Things you'll need:

. Gefen A/V Automation System Processor
. Gefen PACS / Mini PACS
. Local area network (LAN)

In order to install the GAVA (and PACS / Mini PACS), you need to first install and locate
them on your local network (LAN). Installation is simple: Plug them into a spare Ethernet
port on your network and connect the included power supplies. Only plug in one PACS--
after you change its IP address, you can add more.

Locating them on your network and configuring them may be a bit more complicated,
depending upon your network setup. If you have an IT Administrator or consultant, they
should be able to assist you, or you can use some easily available tools to help you do it
yourself.

NOTE: If you have multiple PACS units, connect only one PACS at a
time. After you change the IP address of the PACS, additional PACS
units can be installed on the network.

Depending upon the configuration of the network, locating, installing, and configuring

the GAVA / PACS / Mini PACS may be complicated. If you have an IT Administrator or
consultant, they should be able to assist you. There are also some tools that are available
in order to help do it yourself.

Using the Fing App
The best network setup tool is a free iPod/iPad App called “Fing - Network Scanner”.

Search for it on the Apple App Store and download it to your device. There is an Android
version available as well.




CONNECTING THE GAVA

Download and install Fing on your mobile device.

Make sure your mobile device is connected to the same network as the GAVA and
PACS boxes then open Fing.

Click on the “refresh” icon and a list will appear showing each device on the network.
The devices will initially be shown in order by IP address.
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If the IP addresses do start with “192.168.1...", then you should see a device named
“Gefen” at 192.168.1.72. That is your first PACS. You should also see a device
named “PC Engines” at 192.168.1.82. That is your GAVA. There should be no other
devices using either of those addresses. If there are, unplug them from your network
temporarily, until you change either GAVA or PACS to a different and unique IP
address.

IMPORTANT: There should be no other devices using the default IP
address of the PACS or GAVA. If there are, unplug them from your
Network temporarily, until you change either GAVA or PACS to a
different and unique IP address.

IP Addr ~
Each IP address begins with the same
three numbers (192, 168, and 1).

-
-

f
|

Mobile device running Fing
Fing identifies your device in relation to
other devices on the network.

You should also see the IP addresses of your computers, smart phones, tablets, Apple
TVs, IP Receivers, Blu-ray players, displays, and any other devices on your network.
You should record these IP addresses, especially any that will be controlled by the
GAVA. We recommend you leave Fing running on your handheld device while you
configure GAVA
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Once it is installed, make sure your iPod/iPad/iPhone device is connected to the same
network as your GAVA and PACS boxes, and click the “Fing” icon on your device.
Click on the “refresh” icon and a list will appear showing every device on the network.
The devices will initially be shown in order by IP address.

e

10



CONNECTING THE GAVA

Installing more than one PACS / Mini PACS

If you will be installed more than one PACS in your system, first you need to change the
IP address of the one that is connected to a different IP address that is not being used.
Log in to the first PACS with your browser by entering “192.168.1.72” and change it IP
address, following the directions in the PACS User Manual. Then you can add the next
PACS.

1. Change the default IP address (192.168.1.72) of the last PACS that was
installed on the network.

2. Connect the next PACS to the network.

3. To connect additional PACS units, repeat steps 1 - 2. Refer to the PACS User
Manual for more information.

Normally, only one GAVA will be installed on a single network, as it can
communicate with multiple PACS and other IP-controlled devices. If there is a
reason why you require more than one GAVA on your network, you must change
the IP Address of the first GAVA before adding another.

1"



USING THE GAVA WIZARD

Introduction

The GAVA uses an intuitive Web interface which allows easy addition and configuration of
devices to the GAVA. Before using the interface, the IP address may need to be configured
on the GAVA. See the instructions beginning on page 4 for more information.

1. Using any Web browser (Safari® is preferred), log into the IP address of the GAVA.
The GAVA Welcome screen will be displayed.

2.  Click one of the boxes on the Welcome screen to enter the GAVA Wizard.

12



USING THE GAVA WIZARD

The Control Gateway sidebar button should now be open on the left-hand side of
the screen.

Once the Control Gateway tab is opened, a Quick guide is displayed on the right
side of the screen. This tab provides a step-by-step list of instructions to help guide
you through the setup process.

Home
Quick guide

Quick guide (step by step)

L_|| 1. Add your Control System for Building Automation & A/V on the le
2. Create a new room. In this step you can select between three te

have saved your version you can click "Save and Configure” to sta

details.

3. Once you are done with your Room settings go “Back to main m
many rooms as you wish.

4. You can also create a Multi-room setup and combine your Rooms
recommended to first complete all the rooms and then add them to

5. After you have setup all your devices you can also create macros
commands to one button on your home-screen.

6. On the "Finish" page you can modify your views and select your

To get back to the Quick Guide click on Gefen Logo.

13
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On the bottom-right portion of the screen, are two links: Clicking on one of the links
will display the GAVA User Manual. The other link will display this Quick-Start Guide.

Context-sensitive help is also available by clicking the “?” icon in the top-right corner of
the screen. Internet connectivity is required to use the context-sensitive help.

Help

Click this button to display context-sensitive
help. You must be connected to the Internet
in order for the help file to be displayed.

GAVA User Manual

Click this button to display the GAVA User
Manual (this documentation). An Internet
connection is not required to display the
User Manual.

GAVA Quick Start Guide

Click this button to display the GAVA Quick-
Start Guide. An Internet connection is not
required to display the Quick-Start Guide.

14
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Layout and Design Flow

The GAVA Wizard is designed for easy navigation and is ordered in such a way to provide
a step-by-step process for configuring your entire A/V setup. Therefore, it is important that
each button or tab be completed in the order in which it is presented.

. When using the set of sidebar buttons on the left side of the screen, make sure to
always start at the top-most button and work your way down.

. When working through sidebar buttons that use multiple tabs (on the top-portion of the
screen), make sure to always start at the left-most tab and work your way to the right.

15
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Using the Sidebar Buttons

The control panel on the left side of the screen allows easy navigation of each section
during the set-up process.

. Left-click on any closed section to expand it. The desired section will expand
to display the available options:

16
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. Left-click on the expanded (highlighted) section to close it:

. Left-click on any section that was closed to expand it once again:

17



USING THE GAVA WIZARD

Basic Configuration »

The Network sidebar button allows you to configure the GAVA for use on a network.

DHCP checkbox
( 2

IP Address Left-click this check box to enable DHCP.

Enter the IP

address of the For the best system reliability, it is

GAVA in this field. recommended that a manual IP address,
outside of the DHCP range of the router,
is specified.

DHCP v

IP Address ~— |192.168.1.222

MNetmask 255.255.255.0 ‘ﬁ

Gateway 192.168.1.1

DNS

192.168.1.1
A

Netmask
Enter the network subnet
mask in this field (usually
255.255.255.0).

Gateway
This is the IP address of your
router.

Nameserver

This is usually the same as the
router IP address, unless you
have a separate DNS server.

18



USING THE GAVA WIZARD

Save and Restart

N
If you made any changes, left-click this
button to save all changes and restart
the GAVA.

MAC Address ——

The MAC address of

the GAVA

<

MAC Address

Serial number

Timezone

00:0D:B9:1C:37:70 «——

NS4GHG50EGFS <

America/Los_Angeles

Serial number /

This is the Electronic Serial Number
(ESN) for the GAVA unit. This serial
number is used by Gefen Technical
Support when your GAVA is connected
to the Gefen Support Server.

This number is different from the
Manufacturing Serial Number.

Timezone
Left-click in drop-down list to
select the current time zone.

19



USING THE GAVA WIZARD

Basic Configuration »

The Software Update screen displays the version information for the Device Library and
system firmware that is currently installed on the GAVA. This screen also allows you to
check for newer version of firmware. If a newer version of firmware is discovered, then it
will be displayed under the “available” column.

NOTE: Internet access is required to check for and install updates.

Check for Updates
Click this button to check
for firmware updates

Update

Click these buttons to install the updates once

they have been downloaded. The top Update

button updates the Device Library. The bottom
Update button updates the system (HTML and
Controller) firmware.

20

Versions marked in
red, indicate that a new
version is available for
download.



USING THE GAVA WIZARD

Basic Configuration »

The Support screen shows the Customer Support VPN button. The Customer Support
VPN button allows your GAVA to find and connect to Gefen’s Web Server to allow remote
support and troubleshooting. All communications are encrypted for your security, and are
tied to the authenticated serial number of your GAVA System Processor.

In addition, when the VPN is turned on, the “controller” indicator (see page 4 - 5) on the
GAVA blinks twice every few seconds. When the VPN is off the light blinks once every few
seconds.

NOTE: It is recommended that Customer Support VPN be enabled
when setting up a new system. This will aid Gefen Technical
Support in gathering important information when assisting you.
Once the system is operating properly, the Customer Support VPN
can be disabled.

Customer Support VPN

Customer Support VPN
Click this button to enable/disable the i
Customer Support VPN. In the OFF v
state, the GAVA is disconnected from

the Gefen VPN. In the ON state, the
GAVA is connected to the VPN server. Customer Suppnrt VPN

When connected, the IP address
of the Gefen VPN server will be 10.72.0.36
displayed next to this button.

21



USING THE GAVA WIZARD

Basic Configuration »

The Configuration sidebar button allows you to Reset the GAVA back to Factory defaults,
save the configuration data to a file on your computer, or restore an existing GAVA
configuration file to the GAVA Controller.

NOTE: GAVA network (TCP/IP) settings are preserved and will not
be erased if the GAVA is reset or powered-down.

Clear Configuration to Default Settings

Save Configuration to PC

Reset

Click this button to erase
all programmed devices

from the GAVA. All TCP/
IP configuration settings

will be preserved.

Download

Restore Configuration from PC

Upload afile

22



USING THE GAVA WIZARD

Download

The Download Configuration button lets you save the entire GAVA )
configuration to an XML file on your computer. This file may be saved as a
backup, or transferred to another GAVA to copy the entire program (it does

not copy or change the GAVA IP Address).

The filename will be “configuration.xml”. You should ALWAYS change this
name to a unique name before saving it, or you will overwrite any existing
files on your computer.

Clear Configuration to Default Settings

Save Configuration to PC

Restore Configuration from PC

Upload afile "

Upload
The Upload Configuration button lets you restore the entire GAVA
programming from an XML file on your computer. This file may be used as
a backup, or run on another GAVA to copy the entire program (it does not
copy or change the GAVA IP Address).

You may create a “Master Program” with equipment and settings you
frequently use, and then customize it for different customers.

23



USING THE GAVA WIZARD

Adding Control Gateways »

1. Under the Gateway tab, select the Control gateway (PACS & miniPACS) icon.
The System tab will be displayed.

2. Type the name of the control device in the Name field.
3.  Select the Manufacturer and Model using the drop-down list boxes.

4. Type the IP address of the device in the IP Address field. Make sure that
the device (control gateway) is connected to your network.

Name Manufacturer

Type the name of the device Select the device

in this field. Every name in Manufacturer from this

the system must be unique. drop-down list.
Name \—» |New Control ‘
Manufacturer Please Select... A T‘

Model Please Select...

IP Address 000.000.000.000

Model
Select the Model (based
on the Manufacturer) from
this drop-down list.

Ping
See the next page for
information on the Ping

IP Add
ress button.

Type the IP address of the device in this field. Once
the IP address is entered, the GAVA will automatically
“ping” the added device (see the Ping button).

NOTE: Lighting controls are also added here. See page 24 for
instructions on adding lighting controls.

24



USING THE GAVA WIZARD

Example

In the example below, we have added the Gefen Mini PACS as a Control Gateway.

In the example below, take note of the Ping button. If the IP address of the control
gateway is found, then the Ping button will display “Ping OK”. If not, then “Ping Error”
will be displayed. The Ping button can also be clicked to verify the network connection
to the control gateway.

“Pinging” a contol gateway or device is useful during troubleshooting, should any
network issues be suspected.

Ping
If the IP address is found, then the Ping button will
display “Ping OK”. If not, then “Ping Error” will be
displayed.

v

25
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5. Once the control gateway has been added and the IP address verified, click the Save
and Close button to save all changes.

Save and Close

Save and Close —)

Left-click this button to save all
changes..

6. The added device will now appear under the Control Gateways tab.

New control gateway

26
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Adding Control Gateways »

Lutron RadioRA® 2 and HomeWorks® QS systems should first be set up, configured,
programmed, and downloaded to the Lutron controller via the Lutron software before
adding them to the GAVA system. See the Lutron documentation for details. If you have a
KNX system, the following procedure will be similar. See page 130 for details on preparing
the KNX system for use with the GAVA.

After completing the design, programming, activation, and transfer procedure, connect to
the Main Repeater via IP.

Extracting the XML from the Lutron software
1. Using Internet Explorer Web browser, go to http://<MainRepeaterlPAddress>/
DbXmlInfo.xml (where <MainRepeaterIPAddress> is the IP address assigned to
the Lutron Main Repeater.

. When using a static IP address, the IP address is assigned in the RadioRA 2
software.

. When using a dynamically-assigned IP address (DHCP), the IP address can be
obtained from your router’'s DHCP table or by using the Fing utility (see page 7).
Refer to the router documentation for details.
. Example: http://192.168.2.105/DbXmlInfo.xml
2. Click on the File menu at the top of the page in the Web browser.
3. Select Save As...

4. Save the XML file to the desired location on your computer.

Sample XML File

<?xml version="1.0"?>
<!--Copyright 2010 Lutron Electronics Co., Inc. All rights reserved. -=>

<Project>
<ProjectName />
<Copyright>Copyright 2010 Lutron Electronics Co., Inc. All rights
reserved
</Copyright>
<GUID>66fae3053d80464e879861c4d434eal2
</GUID>
<AppVer>05.00.10
</AppVer>
<XMLVer>1.0
</XMLVer>

27
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1.

2.

Adding the Lutron Control Gateway

Click ADD NEW... under the Control Gateways sidebar button and select the Building

automation icon.

Building automation

%

Type the name of the lighting control in the Name field.

Manufacturer

Select the device Manufacturer from

this drop-down list.

Name
Type the name of the device
in this field.

y).

Name

Manufacturer

Model

—p

RadioRA 2 v ‘

Please Select... - ‘
Please Select...
v

Select the manufacturer from the Manufacturer drop-down list.

Select the model number of the Lutron Main Repeater from the Model drop-down list.
In the example below, we will select IP control.
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Using IP Control

If IP control is selected for this model receiver, then the Control tab will provide an
option to enter an IP address:

MName RadioRA 2
Manufacturer Lutron ]
Model Please Select... -

Please Select...
IP

Homeworks QS HPQ 6.2
RadioRA 2 MAIN-REP [2

RadioRA 2 MAIN-REP [1]

Click the Next button in the lower-right corner of the screen.

Under the Control tab, enter the IP address of the Main Repeater in the
IP Address field.

ain Repeater |IP Addre

Add Control

IP Address ‘ 192.168.1.89 <—)

Ping
If the IP address is found, then the Ping button will
display “Ping OK”. If not, then “Ping Error” will be
displayed.
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Using RS-232 Control

If RS-232 control is selected for this model receiver, then the Control tab will provide
an option to select an RS-232 control device:

Add Control

Controller Please Select...

Please Select...

Once the controller has been selected, check the appropriate RS232 check box.

If the selected controller was a PACS, more than one RS-232 port would be available.
In that case, make sure that the RS-232 port that is checked, corresponds to the
RS-232 port connected to the control device.
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Click the Next button in the lower-right corner of the screen.

Adding Elements
Under the Elements tab, click the Upload a file button.

Locate the device . xm1 file on the computer (e.g. 5DbXmlInfo2.xml).
See “Extracting the XML from the Lutron software” on page 24.

Upln‘ahd a file

Select the . xm1 file from the File Upload dialog and click the Open button.

Once the . xm1 file has been imported, the filename and file size will appear next to
the Upload a file button:

Uplnal:l a file 50bXmilinfo2.xml 0.1MB
XML filename J J
The name of the .xml file that was imported. File size

The size of the imported .xml file.
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4. Click ADD NEW... to add an element from the programmed device list to the GAVA
Wizard menu. Add all of the elements that will be used in the system here.
Elements will be assigned to specific rooms later in the Rooms menu.

Type ~ Name
Select the type of control from the Enter a description
drop-down list. Options: Blind, for the element.

Dimmer, Keypad.

Address Save
The address of the element Saves the element to the
(from the XML file).

element list.
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Adding a Dimmer

1.  Select the type of element from the Type drop-down list. For this example, we will
select a Dimmer control.

2. Type an identifier for this device in the Name field.

NOTE: Special characters (e.g. apostrophes, quote marks, etc.) will
be ignored when the element is added to the list box.
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Select the address from the Address drop-down list. This list is automatically created
from the data in the Lutron . xm1 file.

To save the current element and add additional elements, click the
Save button under the Address drop-down list.
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Adding a Keypad

Click ADD NEW...
2. Select Keypad from the Type drop-down list.

3.  Type a description name of the button that will be used to control the device in the
Name field. In the example below, we will assign a button to dim all lights to 50%.

4.  Select the button name from the Status SET drop-down list. Once the Status SET
value is selected, the Status GET value will automatically be assigned, as shown
below.

5.  Click the Save button to add the element to the list box.
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Adding a Shade
Click ADD NEW...
Select Shade from the Type drop-down list.

Type a name for the shade in the Name field.

Select the button name from the Address drop-down list. The selections displayed in
the Address field are generated from within the Lutron software.

Click the Save button to add the element to the list box.
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Adding a Switch
Click ADD NEW...
Select Switch from the Type drop-down list.

Type a name for the switch in the Name field.

Select the button name from the Address drop-down list. The selections displayed in
the Address field are generated from within the Lutron software.

Click the Save button to add the element to the list box.
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Add more elements by clicking ADD NEW...
Click the Save button to add each element to the element list.
Delete elements by clicking the i icon next to the element to be deleted.

Edit / change element settings by clicking on the desired element.

Element name g /— Delete

Click the element name to Deletes the element
change the element settings. from the list box.

N

Import XML File Upload a file
25% <—’ x
50% x
All OFF x
All ON x
Lamp 1 x
The “>>" marks T
indicate that the Lamp 2 ",
element settings are »
being edited. Lamp 3 -
Orrins Window x
Shades Down x
» Shades Up x
Add —— 3 | () Add new...
Adds a new
element.

38




USING THE GAVA WIZARD

6. To complete the addition of elements to the list box and return to the Home screen,
click the Done button in the lower-right corner of the screen.

7. Under the Control gateways sidebar button, the new control (RadioRA 2) will be
displayed.

New control gateway
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Adding Rooms

The Rooms tab allows you to specify zones (rooms) and devices to each room. The
configuration and control data that is specified for each device is then uploaded to the
PACS or Mini PACS.

1. Click the Rooms sidebar button.

2. Click on ADD NEW ROOM...

3. The Room tab will be displayed.

4.  Type the name of the room in the Name field. For this example, we will use the word
“Living Room”.

5. Select the system design that is appropriate from the four options on the right side of

the screen. In the example below, we will select
AVR /| Home Theater Template. The selected template will be highlighted in green.
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Adding Rooms »

Name
Type the name of the room in this field. \

‘ Living Room

. TV / Single Room Template
All sources are connected to different inputs on the TV and are selected by switching

the TV inputs.

. AVR /| Home Theater Template
All sources are connected to an A/V receiver or amplifier. The receiver is connected to
a single input on the TV. Sources are selected by switching inputs on the receiver.
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Building Automation only
Adds and configures lighting and shade control systems for rooms that do not have
video displays..

Click the Save and Configure button.

Save and Configure "h

Save and Configure

Saves the selected room configuration
and room name and continues with the
TV and source configuration information.

The configuration screen for the named room (in this case, “Living Room”) will be
displayed in the top-portion of the screen. Now that the “room” has been created,
the next step is to add devices to the room. The first step will be to add an A/V
receiver.
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Adding Rooms »

1. Fillin the Receiver information under the Basic tab:

Next

Click the Next button after
the Name, Manufacturer, and
Model have been entered.

Name
Type a descriptive name for the
receiver in the Name field.

Name ;» AV Receiver

Manufacturer ~—* |Denon -
Model Please Select... T
Please Select...
--------- RS232 ----m-m--
most_current_models RS-232
IP

most_current_models_IP S
.

Manufacturer

Select the device
Manufacturer from this
drop-down list.
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Example

2. The drivers for the each model will have certain control capabilities. In the list below,
we have selected a Denon amplifier. The model we have selected is the AVR2113.
There are two methods available for controlling this device: RS-232 or IP control.
We will select IP control for this example.

Name AV Receiver
Manufacturer Denon |
Model /—> Please Select... |

Please Select...

most_current_models RS5-232
IP
most _cu rrent_kl}md els IP

Model
Select the model
number based on the
Manufacturer.

Device protocols

Devices may be controlled by IR,
RS-232, or IP, depending upon
the device capabilities. Select the
driver that is most appropriate for
your installation.

3.  Click the Next button in the lower-right portion of the screen the current settings and
continue to the Control tab.

NOTE: The listed drivers have been tested by Gefen and will work for
most models and selected manufacturers. If the selected driver does
not operate your device, then you may learn a new IR driver. See
page 120 for more information.
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IP Control

. If an IP driver is selected, enter the IP address of the Receiver in the
IP Address field.

Add Control to your Receiver

IP Address 192.168.1.74 H Ping OK ‘

I
IP Address Ping J
Enter the IP address If the IP address is found, then
of the receiver. the Ping button will display “Ping
OK”. If not, then “Ping Error” will
be displayed.
RS-232 Port

. If RS-232 control is selected for this model receiver, then the Control tab will provide
an option to select an RS-232 control device:

L

Controller Please Select... -

Add Control to your Receiver

Please Select...
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IR Port

If an IR Driver was selected for this model receiver (e.g. Harman-Kardon AVP-1), then
the Control tab will provide an option to select an IR Port.

The Model drop-down list, under the Basic tab, would allow this selection as shown in
the two steps below:

NAMeE I.H-'\F o

Manufacturer Harman_Kardon

Model ‘PIE&SE Select...

Please Select...
IR

AVR100 .

4.

Click the Next button in the lower-right portion of the screen to continue to the
Function Keys tab.
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Function Keys

Function keys can be assigned to any of the commands that are available from the
drop-down list for the current device.

For this example, we will assign two commands: “play_favorites” and “Pandora”.

1. Select Command from the drop-down list for Function Key 1.

Add your function keys for the Receiver

Function Key 1: —» |[Command |,

Please Select... |
Function Key 2: wﬂﬂe

Macro » |
Command B‘ ‘Nune

‘Nune

Function Key 3:

Command / Macro selection box

Select either Command or Macro from the
drop-down list. Macros must be created
before they can be selected..

2. Click the Next button in the lower-right portion of the screen to continue.
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3. From the drop-down list, scroll down and select play_favorites.

Function Key 4:

Function Key 5:

Function Key 1:

Function Key 2:

Function Key 3:

Add your function keys for the Amplifier

Command j

None

Command | .

Command | .

Command | .

Command |Z|

menu_cn
mplay
mute_off
mute on
net
option

pandora
play_ipod »

play_iradio
play ush

4. Select Command from the action drop-down list for Function Key 2 and then select

pandora from the drop-down command list.

Add your function keys for the Receiver
Function Key 1: Command || |play_favorites
Function Key 2: Command |,| |None
—| |menu_on
Function Key 3: Command |. | |npiay
— mute_off
Function Key 4: Command |, :1:tte_nn
— option
Function Key & [Commana 5] SN
| play favorites ™.
play ipod

Click the Save button in the lower-right corner of the screen.

NOTE: Macros should be created after all devices have been
configured. After creating macros, you can return to this section to
add the macros to the function keys.
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Adding Rooms »

Basic

1. Fillin the Display information under the Basic tab:

Next

Click the Next button after

the Name, Manufacturer, and
Name o Model have been entered.
Type a descriptive name for the
amplifier in the Name field.

MName ;. HDTV

Manufacturer —|Westinghouse -

Model Please Select... .

Please Select...
IR

_.

Manufacturer —/
Select the device Manufacturer from this drop-down list.
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The drivers for the each model will have certain control capabilities. In the list
below, we have selected a Westinghouse display. The model we have selected
is the LD2240.

Name HDTV
Manufacturer Westinghouse |
Model — Please Select... |
Please Select...
IR

_

Model

Select the model
number based on the
Manufacturer.

2. Click the Next button in the lower-right portion of the screen the current settings and
continue to the Input/Output tab.

NOTE: The listed drivers have been tested by Gefen and will work for
most models and selected manufacturers. If the selected driver does
not operate your device, then you may learn a new IR driver. See
page 120 for more information on learning devices.
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Input / Output

Select the output port on the receiver (usually HDMI 1) from the drop-down list on the
left. This port will connect the receiver to the display.

Select the input port on the display from the drop-down list on the right.

Select the command that will be used for audio return (usually the TV) from the
drop-down list. This setting is optional. It should be noted that the term “audio return”
does not always refer to a physical connection (e.g. a separate output from the display
back to the receiver). It may also refer to the Audio Return Channel (ARC) which is
an HDMI 1.4 feature and supported only on specific devices. In either case, this
option selects the command on the remote control that selects the display audio,

not necessarily the connector that the display is connected to.

Receiver Output port Display Input port  Audio Receiver return
The output port on the AV The input port on the ~ Selects the command used
receiver used to connect  display. to hear TV audio through
to the display. the receiver and speakers.

L

How is the A/V Receiver connécted to the HDTV?

A/V Receiver Video Output selection (if selectable)

\—p! hdmi_1 B

HDTV Source Selection (if seIFctabIe]

hdmi_1 N * B

A/V Receiver Audio Return Channel (ARC)

None B

NOTE: The options that are available from each drop-down list will
vary with the manufacturer and model that were selected.
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Click the Next button on the lower-right corner of the screen to continue to the
Control tab.

Control

Select the controller (the device which will control the TV) from the
Controller drop-down list. Earlier in the set-up process, we added the
Gefen Mini PACS as the control device. Therefore, we will use the
Mini PACS to control the IR on the TV.

Add Control to your Display

Controller Please Select...

Please Select...

Controller

Select the controller from the
list of controllers that you have
added.

Once the controller is selected, the type of controls which are available on the
controller will be displayed. In our setup, an IR emitter cable is connected from IR
port 1 of the Mini PACS to the IR sensor of the display. Therefore, we will select IR
port 1, as shown below.
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NOTE: Ports that have already been assigned will be highlighted in
red. For IR devices, you may use a single IR port to connect two (or
more) devices using a dual IR emitter (Gefen part no. EXT-2IREMIT)
or IR Distribution Block (Xantech® or SpeakerCraft®). RS-232 ports
can only be connected to a single device.

3. Click the Next button in the lower-right corner of the screen to continue to the
Function Keys tab.

Function Keys

The Functions Keys are used to send commands to the device that are not included in the
default control screen, such as a Netflix® button, etc

Macros may also be used to assign a command from a different device to the control
screen. In this example, we will assign two commands: “pc” and “aspect”. The “pc”
command will allow use to switch to the VGA input on the display. The “aspect” command
will allow us to cycle through the available aspect ratios provided by the display.

NOTE: Macros should be created after configuring all devices. After
creating macros, you can return to this section to add the macros to
the function keys.

1.  Select Command from the drop-down list for Function Key 1:

A

Add your function keys for the Display

Function Key 1:

Command B‘ ‘NDHE

Please Select... |
WME
Macro [

Command B ‘NDHE

Function Key 2:

Function Key 3:

Command / Macro selection box
Select either Command or Macro from the drop-down list.
Macros must be created before they can be selected..
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From the drop-down command list, scroll down and select pc.

The drop-down list includes all commands that are in the driver for that particular
device.

Add your function keys for the Display

Function Key 1: Command || [None
. —| linput_toggle
Function Key 2: Command |, left
—  menu_home
| |menu_osd
i : Command |, -
Function Key 3: mute

onedigit_twodigit

Function Key 4: Cemmand |. ﬂEtinns

power_off .
Function Key 5: Command | . power_on

L] power_toggle

red

return

Select Command from the drop-down list for Function Key 2 and then select aspect
from the command list:

Add your function keys for the Display

Function Key 1: Command |.| |pe

Function Key 2: Command |,| |None

Function Key 3: Command |, | 2

—
Function Key 4: Command |, g
Function Key 5: Command |, | lav 1 u.
— blue

cancel
cc
channel_down
channel_up
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Click the Next button in the lower-right corner of the screen.

Adding Favorite Channels

Up to 12 Favorite channels can also be added: Select the channel name from the
drop-down list and enter the channel number in the Channel number field.

NOTE: This page selects Favorite Channels from the TV tuner. If you
have cable or satellite service, you should add your favorite channels
to your set-top box, instead.

Click the Save button in the lower-right corner of the screen to save all changes. The
next step will be to set-up the source devices.

NOTE: If the icon for the selected channel is not in the list, type the
channel name in the drop-down list box.
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Adding Rooms »

Adding a Disc Player
Example

Basic
1.  Click the Disc Player icon.

Disc Player

S

Enter a description of the source device in the Name field. In the example below,
we have added the name “player” to the device name. This is because the name

“Blu-ray” is already used by the RadioRA 2 control gateway. Each device name
must be unique.

Name ‘Elu-rav,r player

Manufacturer ‘PIEESE Select...
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3. Use the drop-down lists to select the Manufacturer and Model of the source device.

L

Name Blu-ray player ‘
Manufacturer Sony .|
Model Please Select... |

Please Select...

IR
DVP-CXB&0 Changer
bdps185
most_current_models

4. Click the Next button in the lower-right corner of the screen to continue.

Control

1. Select the input for the display device from the Video and Audio drop-down list. In
this example, the display device is using bd (Blu-ray Disc).

The Only Audio drop-down list is used when an audio distr bution system is also
being added to the system.

Which input on A/V Receiver do you use?

Video and Audio ‘bd s T‘
. |

Only Audio ‘Nnne T‘
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2.

Click the Next button in the lower-right corner to continue to the Control tab.

Since the Gefen Mini PACS is our controller, we will select it from the Controller drop-
down list.

Check the box for the method of control. In the example above, an IR emitter is
connected from IR port 2 on the Mini PACS to the set-top box. Therefore, we'll check
IR port 2 as the control port.

Note in the example above, that IR port 1 is colored red. This means that this IR
output has already been assigned on the Mini PACS. This port was assigned in step 2
on page 52, when adding IR control for the HDTV.

If the check box is checked on a port, then a “Port is already in use!” message will
be displayed near the bottom portion of the screen. The port can still be used (for
instance if a dual IR emitter is present on IR port 1). However, the GAVA will provide
this warning as a notice.

® VI

1 2 3

! Port is already in use!
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4. Click the Next button in the lower-right corner of the screen to continue to the Function
keys tab.

Function Keys

The function keys can accept commands (On, Off, Channel Up, etc.) or macros which are a
set of commands that perform a specific task.

1. Select the desired commands to be added from each of the drop-down lists.

2. Click the Next button in the bottom-right corner to continue.
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3. Click the Save button to in the lower-right corner of the screen to save the changes
and return to the Source tab.

4. Add more sources by clicking ADD NEW...

5. Create additional rooms by clicking the Back to main menu tab and clicking the
Rooms tab on the left-hand side of the screen.
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Using iTunes® with the GAVA
The GAVA not only allows control of displays and video sources but also your music

collection using iTunes. When configured, an iTunes device control will appear in the
Device Panel within the GUI.

Example
1. Click the Rooms tab on the left portion of the screen.

2. Click on the room to which iTunes will be added. In our example, we will be adding
iTunes to the room we created earlier (“Living Room”).

3. Click the Sources tab to display the current list of sources.

4. Click ADD NEW...

NOTE: Before proceeding, make sure that iTunes is installed and
operating correctly on your computer. The computer that is running
iTunes should be connected to the audio inputs of an A/V receiver.
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5. Click the iTunes icon.

6. Provide a name for the iTunes control in the Name field.

7. Enter the IP Address of the computer that is running iTunes in the IP Address field.

‘ "

‘ New iTunes ‘

Name

IP Address

A

Name —J Ping

Type a descriptive name for the
iTunes device in this field.

Ping

If the IP address is found, then the
IP Address Ping button will display “Ping OK”.
Enter the IP address of the computer If not, then “Ping Error” will be
that is running iTunes. displayed.
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If you do not know the IP address of the computer that is running iTunes, use the
following steps to obtain this information.

Microsoft™ Windows®

. On the computer running iTunes, click on the Start Menu button and then select
Run. Under Window Vista® and Windows 7®, select the Search programs and
files field.

. Type command in the Run dialog and press Enter.
. In the command window type ipconfig and press Enter.

. Locate the IP address of the computer in the command window.

t Corporation. All rights
config
IP Configuration

Ethernet adapter Local Area Connection:

IP Address

Mac OS X

. On the computer running iTunes, select System Preferences from
the Apple menu in the upper-left corner of the screen.

. Click on the Network icon.

. The IP address will be displayed under the Turn Airport On/Off
button on the right side of the screen.
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Ping f

If the IP address is found, then the Ping button
will display “Ping OK”. If not, then “Ping Error” will
be displayed. Once a control device has been
successfully added, click this button to “ping” the
device, should any network issues be suspected.

v

8.  Click the Next button in the lower-right corner of the screen to continue to the Input
tab.
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Input

1. Under the Input tab, select the input on the receiver using the Only Audio drop-down

list.

In our example, we will connect the audio output from the iTunes computer to the CD

input on the receiver.

Only Audio

Which input on A/V Receiver do you use?

Please Select...

Please Select...
aux_1
bd

F

game
iradio
lastfm
net
pandora
sat chl
scene 0
scene_1
scene 2

m

2. Click the Save button in the lower-right portion of the screen. The iTunes device will
be displayed under the Sources tab, on the left.

3. Click the Back to main menu tab in the lower-left side of the screen.
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Using Apple TV® with the GAVA
The GAVA allows direct IP control of your Apple TV (series 2). Apple TV can also access

your iTunes music collection. When configured, an Apple TV device control will appear in
the Device Panel within the GUI.

Example

1.  Click the Sources sidebar button on the left portion of the screen.

2. Click ADD NEW...

NOTE: Before proceeding, make sure that iTunes is installed and
operating correctly on your computer. The computer that is running
iTunes should be connected to the audio inputs of an A/V receiver.

3. Click the Apple TV icon.
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4.

5.

Provide a name for the Apple TV in the Name field.

Enter the IP Address of the Apple TV in the IP Address field.

h R

Name

IP Address

New AppleTV

[

Name —/

Type a descriptive name for the
Apple TV device in this field.

Ping

Ping
If the IP address is found, then the

IP Address

Ping button will display “Ping OK”.

Enter the IP address of the computer If not, then “Ping Error” will be

that is running Apple TV.

displayed.

Under the Input tab, select the input on the receiver that selects the Apple TV.

Video and Audio

Only Audio

Which input on A/V Receiver do you use?

aux_1 - ‘

Please Select...

bd .
cd
dvd
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Adding “Generic” Sources
You can use the “Generic” Source option to add input selection of devices that do not have
control options, such as Cameras, Tuners, or other internal sources on your Receiver.

You can name the source, select a Receiver input, and add up to five Function Keys to add
Macros to the screen for the Generic device. A sample “tape deck” device is shown below.

Generic source button

; Macros

Only macros can be used
with “generic” devices.
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Adding an A/V Matrix

Once all your devices are setup in each room, you can add and setup a matrix to control
each device. We recommended that you add and configure all devices in each room
before adding a matrix.

1. Open the Rooms tab and click ADD NEW A/V MATRIX DEVICE...

For illustrative purposes, a second room (“Bedroom”) has already been created and is
visible under the Rooms sidebar button.

2. Provide a name for the matrix in the Name field.

—

Name ——8M8M8

Enter a descriptive name
for the matrix A/V device.

3. Click the Save and Configure button in the lower right corner of the screen.
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4.  Enter a description of the source device in the Name field. This name must be
different than the matrix name provided in step 2.

5. Use the drop-down lists to select the Manufacturer and Model of the
source device.

6. Click the Next button in the lower-right corner of the screen to continue.

4

Name Matrix ‘
Manufacturer Gefen -
Model Flease Select... -

Please Select...
RS232

EXT-DVI-444DL RS-232

EXT-HDFST-848CPN RS5-232 h‘

Controlling the Matrix

1. Select the control device in the Controller drop-down list. In our setup, we are using
the Gefen Mini PACS.

Add Control to your Matrix

Controller Please Select... -

Please Select...
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2. Select the RS-232 control port.

N

Add Control to your Matrix

Controller Mini PACS

L

Click the Next button in the lower-right corner of the screen.

Select the outputs and inputs to connect the matrix to each device. The specified

outputs and inputs in the software must match the physical connection of each device

to the matrix.

Outputs ~
Select the Room and Device
connection to each matrix output
port from the drop-down list

Inputs
Select the input port
on the device, that is
connected to the matrix.

\

Define Matrix Output conn

Matrix Output 1 is connectpd to:

ions:

\/
Bedroom - HDTV BEJFDDI'I'I

Matrix Output 2 is connected to:

Please Sel

Please Select...

‘Living Room - AV Receiver

bd

7




USING THE GAVA WIZARD

Adding a Room to a Matrix (Selecting Matrix Outputs)

Select the Room and Device connected to each matrix output port from the
drop-down list.

Select the input on the Device that selects the Matrix source.

Adding System Sources (Selecting Matrix Inputs)

You can add Sources that are available to many or all Rooms through an Audio/Video
Matrix. The procedure is identical to adding a Source directly to a Room, except that the
Source is added to a Matrix input. The Source will appear in every Room that is connected
to the Matrix. When that Source is selected, GAVA will automatically switch the Matrix to
the proper input for the Source, and select the Matrix Output for that Room.

1.

2.

Click ADD NEW... to add more sources to the matrix.

Click the Back to main menu tab in the lower-left portion of the screen to return to
the Rooms tab. The Rooms tab will now display the system hierarchy in relation to
the matrix. In the example below, the Bedroom and Living Room are highlighted and
indented to indicate that they are connected to the matrix.

Click the Finish Project tab to proceed to the Views tab.

edit ———— Delete
Click to change the name Deletes a room
of the room or matrix. or matrix.

— Name

Click on the name of the room or
matrix to edit the devices.
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Adding Building Automation

We have already added the Lutron RadioRA 2 control gateway. However, we will need to
add these controls to the room (“Living Room”) we created. The automation controls will
appear in the device panel.

1.  Click the Building Automation tab. The RadioRA 2 control gateway
will be displayed.

2. Click on RadioRA 2.

3. The list of available elements for the RadioRA 2 device will be displayed on the right-
hand side of the screen under the Available list box.

Available

\ 25%,

50%
All OFF

All ON
Lamp 1
Lamp 2
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4. Select the desired elements by clicking on them. After an element is selected, it will
be highlighted and appear under the Selected heading.

/— Highlighted control elements
The highlighted control elements will
appear under the Selected heading.

Available

25%

» 50%
» All OFF
» All ON

il

Selected

50% < (]
All OFF E
AION - J E

Move Elements
Changes the order of element within
its respective group. See the next
page for more information.

. To delete elements from the Selected list, click on the respective element under the
Available list box. The selected element will no longer be highlighted and removed
from the Selected list.

. To arrange elements, use the E and icons to move the elements within
the Selected list.
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Arranging Control Elements

Each element (Dimmer, Keypad, or Shade) can be arranged differently within the GUI,
based on the control type. If we look at our current setup, we added all the available
control elements:

Available Selected
B 25% 5“%

> 90% Lamp 1

» All OFF

» All ON Orrin's Window
» Lamp 1 25%

»Lamp 2 All OFF

>Lamp 3 All ON

» Orrin's Window

» Shades Down Lamp 2

» Shades Up Lamp 3

Shades Down

Shades Up

Each element has been added to the Selected list. The order of elements under the
Available list is not important. However, the order of the Selected list can be changed,
but first let's see how our control elements would be displayed in the GUI if we did not
rearrange them.
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The illustration below shows the Keypad control screen, under the device panel
compared with the order of each element under the Selected list.
Notice that the order of each button is the same as the Selected list.

Selected
50% \
Lamp 1 s
Orrin's Window

| »
25% — |
All OFF >
All ON —_— 1
Lamp 2
Lamp 3 |

Shades Down —|

;

Shades Up —

Example
Now let’'s say we want the Keypad elements to appear in the following order: “25%”,
“50%”, “All On, “All Off”, “Shades Up”, “Shades Down”.
Click the Building Automation tab.

Click RadioRA 2.

Use the E and E buttons to move each elements under the Selected list.
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After changing the order of the elements, the elements under the Keypad device
panel will appear as follows:

Selected
25% \

50%
\

Lamp 1 [~

Orrins Window

All ON >

AllOFF —
Lamp 2
Lamp 3

\
\

Shades Up —

\
!

Shades Down —]

This same procedure can be used to change the order of Dimmer and Shade
elements.
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Adding Macros
Macros are used to assign a sequence of events to a single function key:
1) Turn on the TV. 2) Dim the lights by 80%. 3) Open the curtains. 4) Start the projector
(or playback device). Although each of these events could be done through different

buttons on a remote control, assigning these events to single button on the remote control
is much more convenient.

Example

1. From the Home screen, click the Macros tab on the left side of the screen.
2. Click ADD NEW...

3. Type a descriptive name for the macro in the Name field. In the following example, we
will create a macro for “Power ON” which will power-on all our devices.

Name
Create a descriptive name for
the macro.
Mame ‘ Power ON
|
Device Command Value

iPIease Select... §v|| ‘Please Select... E” |

Please Select...
Mini PACS
RadioRA 2

— | Matrix

HDTV Bedroom
DirecTV

AV Receiver
Apple TV
Blu-ray player
iTunes
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Select the device (HDTV) that will receive the command from the Device drop-down
list. In this example, the macro will be received by the HDTV device.

Select the command from the Command drop-down list.

Command ~N
Select the command from the
Command drop-down list.

The list of commands will be

dependent upon the selected

device.
Device Command v Value
HDTV E| ‘PUWEr_tuggle ] [~

79



USING THE GAVA WIZARD

6. If the Command needs a “value” (such as “Set_Volume=50%"), enter the value (50) in
the Value field.

Value
Enter a value for the number of
times that the command will be
executed.

Command Value vy

E” |puwer_tuggle E” ‘1

Command Value Delay

|Z|| |pnwer_tnggle E” |1 ‘ |25’D |

Delay
The number of milliseconds
before the next command in the
list is executed.

7. Enter the delay (in milliseconds) in the Delay field. This value represents the number
of milliseconds before the next command is executed. For this example, we will leave
the Delay set to the default value of 250.

The maximum value is 9999 (approximately 10 seconds).

80



USING THE GAVA WIZARD

8. Click the Add command button in the lower-left corner of the Macro screen to add
another command.

J

f

Add d Add command
comman Adds a new device command to
the current macro.

9.  Fillin the information for the A/V Receiver, as shown below.

Device Command Value
|HDTV E‘ |PUWEr_tugg|e E| ‘

=i

|AN Receiver E” | power_on
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10. Add a power_on command for the Blu-ray player by using the Add command button.

. Use the E\ icon to deleted a macro.

. Use the E\ and icons to change the sequence of macro events.

[=][=][=]
[l «][«]

11. Click the Save and Close button to save the “power ON” macro.

Save and Close
Save and Close Click this button to save the
macro and close the Macro tab.
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12. Repeat steps 3 through 9 to create a “Power OFF” macro.

13. After the “Power OFF” macro has been created, both the “Power ON” and “Power
OFF” macros should appear under the Macros tab, as shown below.

14. Click the Save and Close button to save the “power OFF” macro.

15. Click the Finish Project tab on the bottom-left portion of the screen.
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Assigning a Macro to a Function Key

Once a macro has been created, it will appear on the Home screen of the selected GUI
(see page 57). Macros can also be assigned to Function Keys.

Example

1.  Open the Rooms tab and click on the name of the Room.

2. Select the Display tab, on the left side of the screen.

3. Click on the Function keys tab.
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4. Select Macro from the drop-down list next to an unassigned Function Key. In our
example, we will select Function Key 3.

. S [

Function Key 3: Command ;. ‘

) Please Select...
Function Key 4: Command

Function Key 5:

5.  Since we already created a macro called “Power ON”, select this macro from the
command/macro drop-down list.

I |
None -
None

Power OFF

85



USING THE GAVA WIZARD

Click the Save button near the bottom-right corner of the screen.

After the GUI is generated, Function Key 3 for the HDTV device will be programmed
with the “Power ON” macro (shown below).
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The Views tab lets you create different Graphical User Interfaces (GUI’s) for different
devices. For example, the iPad you use in the Living Room can show only the Living Room
system, while the iPod Touch in the Bedroom can show just the Bedroom system. Or the
Kids’ iPhone can be set to have access only to the Kids’ Bedroom system.

You can also “hide” Device controls that are not ordinarily used, and change the order
of selections, so the Blu-ray player and Apple TV are always visible, while the Receiver
controls, which are rarely used, are at the end of the list (of course, the Receiver Volume
slider is always visible).

You can create as many “views” as you need- each has a different URL. If you use the

“Add To Home Screen” option on your iPad, iPod, or iPhone (see page 95), the URL will be
hidden, and only the selected GUI will be available
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View buttons

Each view that is created using the Add view button will have
an associated View button. Click the desired View button to
show the associated view. The button name for the currently
selected view will be highlighted.

Move Device

\&_ View name Changes the order of each device in
Type the name of view in this the device panel. Click the Up arrow
field, then click the Add view to move the device to the left, and the
button to add the view. Down arrow to move the device to the

right.

88



USING THE GAVA WIZARD

1. Type the name of the view to be created in the view name field. In our example, we
will use “Bedroom”. Because we have two rooms (“Living Room” and “Bedroom”) we
will want to define the devices in each room.

2. Click the Add view button.

Once the Add view button is clicked, a button with the name provided in the View
name field will be created.

Add view
Click this button to create a View button.

Delete
Click this portion of the View button to
delete the current view.
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Additional views can be created by following steps 1 and 2. For this example, we will
only create two views: “Standard” and “Bedroom”. At least one View name must exist.
The default view name (“Standard”) cannot be renamed or deleted.

In this example, the “Living Room” will be using the Standard view.

Click the Standard button to return to the default view. The Standard button will be
highlighted.

Disable the devices from under the Bedroom zone by left-clicking in the check boxes.
Use the scroll bar, if necessary, to view all added devices. The Views screen should
now appear similar to the illustration below:
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Generating the GUI

After all devices have been added to the GAVA system and the Views have been set up,
using the Web interface, the final step is to generate the GUI.

1.

Starting from the Views tab, click the Next button in the lower-right corner of the
screen to display the GUI-Screens tab. The GUI-Screens tab will display the different
types of GUI that can be generated:

. 3.5” (diagonal)
Compatible with Apple iPod Touch, 3.5” Apple iPhone and
7” Samsung Galaxy Tablet.

. 9.7” (diagonal)
Compatible with 9.7” Apple iPad.

. 10.1-inch (diagonal)
Compatible with Samsung 10.1” Galaxy tablet

NOTE: Multiple GUI screens can be selected / generated by selecting
the desired GUI configurations from GUI-Screens tab.

For our example, we will generate a GUI for 3.5-inch (diagonal) and
9.7-inch (diagonal) devices. The selected GUI screen(s) will be highlighted in green,
as shown below.

Note that the Portrait and Landscape options have also been checked. This
option allows the GUI to “fit-to-screen” if the device is held vertically or horizontally,
respectively.
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3.

4.

Click the Create config button in the lower-right corner of the screen to begin
generating the GUI. A progress bar will be displayed as the GAVA configures and
uploads the controller data to the PACS / Mini PACS.

After about 30 - 60 seconds, a screen similar to the following will be displayed,

depending upon the number of rooms that were created and the number of GUI
interfaces that were generated.

Name URL

iPhone Standard http://192.168.1.222/7project=P1
iPhone Bedroom http://192.168.1.222/7project=P2

iPad Standard http://192.168.1.222/?project=P3
iPad Bedroom http://192.168.1.222/?project=P4

Back
Click this button to return to the
GAVA Wizard and make changes.

The GUI interface(s) is/are now ready to use. Click the link of the desired GUI to

be opened or type the IP address of the GAVA directly into the Web browser on the
mobile device.
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Pairing iTunes with the GAVA
In order for the GAVA to be able to communicate with iTunes, it must be paired with the
GAVA. The pairing procedure is performed after the desired GUI(s) have been successfully

rendered (see page 84). This procedure is only necessary if iTunes was added as a source
device.

1. Launch iTunes.

2.  Click the Start button on the “Finished!” screen.

3. Locate the IP address on the left side of the screen, under DEVICES:

IP address
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The IP address will be preceded by the word “GAVA @”. In our example, the IP
address is GAVA @ 192.168.1.222. The IP address is the same
as the GAVA.

4. Click on the IP address and enter the 4-digit passcode to allow the GAVA to control
iTunes. The passcode is “12 3 4”.

IPhone, IPod touch & 1Pad

Flease enter the passcode displayed on your Remote to allow it
to control iTunes.

1 2 3 4

5. Once the passcode is verified, the following screen will be displayed.

6. Click the Stop button (see step 2) in the GAVA interface. The Stop button will
be highlighted in dark blue when clicked.
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Using the GAVA Graphic User Interface (GUI)

Accessing the GUI on a mobile device

1. Open a browser window on the device(s) you wish to use and enter the IP address of
the GAVA.

Tap the Views menu, just below the address window on the device, to display other
views.

NOTE: The examples below illustrate the use of an iOS device.
Refer to the documentation for your device on how to create icons,
if available.

.

Add to Home Screen icon

2. OniOS devices, click the Action icon and select Add to Home Screen.
Using the Add to Home Screen action lets you create an icon on your Home screen

that will take you directly to the GAVA interface without the Web browser banner from
appearing on the screen.
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3. Provide a name for the icon as shown below and click the Add button to add the icon
to the Home screen.

Add button

- -~

4. Tap the GAVAicon to launch the GUI. A few moments after the splash screen (left)
appears, the main GUI screen will be displayed (right).

97



THE GAVA USER INTERFACE

GAVA Control User Interfaces

Here is the GUI for an iOS device (iPhone). Select the device to control from the menu bar
on the bottom of the screen. The illustration below shows the Home screen with Rooms
and Macros.

Room tab

Displays all rooms that were

created. Tap to select the Activities + Macros ﬁ
desired room. The selected Open this tab to display macros

room will be highlighted. that were created.

Selected room

Volume control
Controls the volume for the selected room.
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~— Device tabs
Tap any tab within the GUI to
expand / open or close the tab.

»

Tap to open the tab.

ofty

J

\

< -

Device Slider Panel

Each device that is added to this
room will appear in this area of the
GUI. The Device Panel will scroll
side-to-side if more than three
devices have been added.
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Disc Player

NAV (Navigation)

Room Name ————
The user-defined room

name. Device Name
The name of the
device.

—

, > N )
Eject Play
Stop Pause
' 4 i il -
; Previous Next —/

; Rewind Fast Forward —/
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Back — Background tab Select
Returns to the previous Select this tab to Press to switch the
device in the Device Panel view the next tab for Receiver to display
this device. Some and list to this source.
devices will have
multiple tabs.
\ 4
/ >
Option J
“Option” function (if available
on this device).

Home Power Toggle _

“Hor#e"dfun.ction (if available Press to power ON and
on this device). power OFF this device.
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Digit tab

“dot” key
This key can function as

either a “.” (dot) or “-” (dash),

depending upon the device.

102

Volume control
Controls the volume for the
current room.
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Set-top Box

NAV (Navigation)

— Digt

Opens the Digit (numeric
keypad) used for channel
selection, etc.

Vol -, Mute, Vol +
These buttons will be displayed in place of a volume
slider, if the room uses IR or one-way volume control.
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Digit tab

DVR
Opens the DVR (Digital Video
Recorder) tab, if available for
this device.

\

/— FAV
Opens the Favorite
Channels tab.

104



THE GAVA USER INTERFACE

DVR (Digital Video Recorder) tab

Record
Record button (if available on
this device).
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FAV (Favorites) tab

; Favorites

User-defined favorite channels will be
displayed here.
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NAV (Navigation) tab

/— Inputs
Allows direct selection of
all inputs.

NOTE: this button is not
used on this screen.
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Inputs tab

Inputs
Allows direct selection of all inputs that are not
available on the Device Slider Panel (see page 98).

108



THE GAVA USER INTERFACE

Display

NAV (Navigation) tab

Switch

Selects the display device as

the audio source. Audio Return
Channel (ARC) is used if available.

Back Power _
Returns to the Power button.

previous page.
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Digit tab

; Function Keys (1-5)
These buttons can be assigned

user-defined functions. See page
55 for more information.
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DVR (Digital Video Recorder) tab
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FAV (Favorites) tab
—_
(- —
=
ﬁ
; Favorites
User-defined favorite channels will be
displayed here. See page 53.
Volume slider J

Use this slider control to adjust the volume in this room.
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Apple TV

Player tab

; Previous / Beginning

Press to go to the beginning of the media or
play the previous media. These button are
used in the Apple TV and iTunes interface.

Next —/

Jump ahead and play the next media file.
Used in both the Apple TV and iTunes
interface.
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NAV (Navigation) tab

114




THE GAVA USER INTERFACE

iTunes

Player tab
/— Album artwork Song Data ﬁ

If the iTunes track contains abum  This information will be
artwork, it will be displayed here. displayed if provided.

\

A

Volume slider
Displayed only if the device is using RS-232
or IP two-way interfaces
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Playlist tab
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Generic Sources

The “Generic” Source is used for Inputs that do not require control, such as cameras, etc.
There are also five “Function Keys” that can be used for stored Macros. See page 68.

Matrix

Normally, there is no need to directly control a Matrix Switcher, as GAVA handles the
switching “behind the scenes”. However, this screen lets you check or change the input
status of all outputs on your matrix.
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Building Automation »

The Dimmers interface displays all the Dimmer and Switch elements that were defined
using the Web interface (see page 33).

Uy \
Back Feedback indicator
Returns to the previous page If the automation system provides
(panel) in the GUI. feedback for a specific state, then

this LED indicator will “turn on”.
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Building Automation »

The Dimmers interface displays all the Dimmer and Switch elements that were defined
using the GAVA Wizard (see page 33).

Sliders
Fine-adjustment of the
brightness of each light.

\ /
- [: o
Off button On button
Set the light to its lowest Set the light to its highest
brightness (OFF). brightness (OFF).
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Building Automation »

The Shade interface displays all the Shade elements that were defined using the Web
interface.

Down Up
Press this button to open the Press this button to
shade. retract the shade.

Press in the middle to stop
the shade, after pressing the
Down or Up button.
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Learning a New Device

The GAVA is shipped with a library of various devices. Even if your specific model is not
listed, each manufacturer supplies a standard set of IR commands that are common to
their product (e.g. the Sony XBR4 and XBR?7 share a set of similar IR commands). When
learning a new device, the GAVA automatically provides you with a template based on the
type of device that is being “learned.”

The GAVA requires that IR commands have specific name conventions that are matched
to the GAVA User Interface buttons. Templates provide an easy way to ensure that new
devices have the proper names. Using a template also allows you to just push buttons on
your IR remove as prompted, without having to simultaneously enter names and navigate
the screen on your computer.

The GAVA comes with several pre-configured templates which are needed to build a GAVA
library. Each of these templates correspond to a different class of IR-controlled device.

In the following example, we will add a new source to the “Bedroom” which we created
earlier.

1.  Open the Rooms tab on the left side of the screen.
2. Select the room called “Bedroom”.
3.  Click the Sources sidebar button and click ADD NEW...

4. Select the source device type (Disc Player, Set-Top-Box, etc.) from the list of icons
on the right-hand side of the screen.

5. Under the Basic tab, click the Learn new device button.
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Type the Name, Manufacturer, Model, and Controller.

Select the controller from the PACS drop-down list. The available choices will be
defined by what Control Gateways were defined (PACS and/or Mini PACS).

Manufacturer ﬂ

Name ~ Select the device
Type the name of the Manufacturer from this
device in this field. drop-down list.

Model PACS
Enter the model Select the controller from
number in this field. the drop-down list.

Start learning

Click this button once
all information has been
entered.
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Click the Start learning button.

The GAVA will begin loading the appropriate template.

Please stand by while uploading template...

Refer to the PACS / Mini PACS manual for learning IR commands.
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Setting the IP Address

Before connecting the GAVA to a network, locate the label on the bottom of the GAVA. The
MAC address and the default IP address will be listed on the label. The default IP address
(192.168.1.82) will be used to connect the GAVA to the network.

IMPORTANT: Because all GAVA units have the same default IP
address, only one GAVA should be connected to a network at a time.
If more than one device with the same IP address is connected to a
network, the computers will be unable to locate any of the devices.

/— ESN
Electronic Serial Number

—
/—

82<j

MAC P
Primary MAC gddress of. The default IP address
the GAVA. This address is of the GAVA.

different for each unit and
cannot be changed.
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The computer must have an IP address in the same subnet as the GAVA, but with an
address that is different from the GAVA address. If you computer has an IP address of
192.168.1.xxX,and 192.168.1.82 is an available address, you can access the GAVA
by entering 192.168.1.82 in your Web browser.

Otherwise use the following procedure to change the IP address on the GAVA to match the
network settings:

1. Access the Network Setting control panel in Windows and locate your LAN
connection. Under Windows 7®, this can be done by clicking Start > Control Panel >
Network Sharing Center > Change Adapter Settings.

2. Click on the Local Area Connection icon to display the Local Area Connection

3.

Status dialog:

Click the Properties button to display the Local Area Connection Properties dialog.
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Click on Internet Protocol Version 4 (TCP/IPv4).

Internet Protocol Version 4 (TCP/IPv4)
Click to highlight this Network protocol. )

A

Click the Properties button to display the Internet Protocol Version 4
(TCP/IPv4) Properties dialog.

STOP: Before continuing, write down the current IP settings listed
under this dialog box before making changes. These settings

will need to be restored later. If the Properties are set to “Obtain
an |IP address automatically” and “Obtain DNS server address
automatically”, you do not need the actual address settings.
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6. Change the IP settings to the following:

Subnet mask

255.255.255.0

~— Use the following IP address
Click this radio button.

IP address*
192.168.1.80 )

{ . )
-«
B <

L

“— Use the following DNS server addresses Clear these boxes. —)
Click this radio button.

*If the IP address 192.168.1.80 is already in use on your network, select another unused
address thatisnot 192.168.1.720r192.168.1.82 or the router’s IP address. Do not
use an IP address that is used by a PACS controller on the network.
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10.

1.

12.

Click the OK button, then close all Control Panel windows.

Refresh your Web browser and go to http://192.168.1.82 to open the GAVA
Web interface.

Go to the Configuration Menu (see page 35) and change the IP address for the GAVA,
to an appropriate address for your network.

Click "Save Changes”, “Reboot”, and “OK” to save the new IP address.
Reopen the computer’s network settings and restore the original settings (or go
back to “Obtain an IP address automatically” and “Obtain DNS server address

automatically”, if those were the original settings).

Refresh the Web browser and type in the new IP address for the GAVA to reopen the
GAVA Web interface.
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Browser Recommendations for GAVA

The following list serves as a guideline to determine which browser on which operating
system is best suited for HTMLS5.

The order reflects evaluation or recommendation

The version number is listed in brackets

Windows® (earlier than Windows 8)

1. Apple Safari (> 4), Google Chrome (>20), Mozilla Firefox (>13)
2. Opera (>11)

3. Internet Explorer (8, 9)

Windows (Windows 8 or later)

1. Apple Safari (>4), Google Chrome (>20), Mozilla Firefox (>13), Internet Explorer
(10)

2.  Opera (>11)

Mac OS X
1.  Apple Safari (>4), Google Chrome (>20), Mozilla Firefox (>13)
2.  Opera (>11)

Linux
1. Google Chrome (>20), Mozilla Firefox (>13)
2. Opera (>11)

Apple iOS (5/6) - iPhone®, iPad®, iPod® touch

1. Dolphin Browser or Mercury (offers full-screen and multitasking)
2. Safari and/or as Web App on the Home screen

3. Google Chrome

4. Opera

Android

1. Google Chrome (Android 4 only)

Mozilla Firefox BETA (Android 4 only), Opera (Android 4 only)
Dolphin Browser (Android 2 or 3)

Mozilla Firefox (Android 2 or 3)

“Internet”, Opera (Android 2 or 3)

o M @D

Other: Please note the following support link for Opera:
http:/techdows.com/2010/12/enable-websockets-in-opera-11.html
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2.

Using the GAVA with a KNX Automation System

As with the Lutron RadioRA® 2 and HomeWorks® QS systems, it is important that the

KNX system be set up, configured, and functioning properly before attempting to add this
automation system to the GAVA.

1. Obtain the *.esf file from the KNX installer / electrician. The *.esf file is generated by

the KNX ETS software by using the “File > Extract Data” function.

Choose “Export Foreign Format”, and “Export to OPC Server”. See next page for
illustration.
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3. Get the gateway information from the installer / electrician. In most cases,
a KNX IP-Router device will be used. However, GAVA can also use a KNX Tunnel

device as the gateway.

KNX IP-Router

4. Have the installer / electrician provide the physical address of the gateway.
This address is a typical bus address (e.g. 0.0.254). The IP address of the
gateway can also be entered in the GAVA Wizard.

5. Upload the .esf file to the GAVA. See the sample .esf file on the next page.
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Sample ESF File

GAVA KNX SAMPLE FILE

CENTRAL.LIGHTING.0/0/1 CENTRAL.LIG.ON/OFF EIS 1 ‘switching’ (1 Bit) Low
CENTRAL.LIGHTING.0/0/2 CENTRAL.LIG.VALUE EIS 6 ‘Scaling - percent’ (8 Bit) Low
LIGHTING.DIMMER.1/1/0 CHANNEL.A.ON/OFF EIS 1 ‘switching’ (1 Bit) Low 0/0/1
LIGHTING.DIMMER.1/1/1 CHANNEL.A.RelDIM EIS 2 ‘Dimming - control’ (4 Bit) Low
LIGHTING.DIMMER.1/1/2 CHANNEL.A.VALUE EIS 6 ‘Scaling - percent’ (8 Bit) Low 0/0/2
LIGHTING.DIMMER.1/1/3 CHANNEL.A.STATUS.ON/OFF EIS 1 ‘Switching’ (1 Bit) Low
LIGHTING.DIMMER.1/1/4 CHANNEL.A.STATUS.VALUE EIS 6 ‘Scaling - percent’ (8 Bit) Low
LIGHTING.DIMMER.1/1/10 CHANNEL.B.ON/OFF EIS 1 ‘switching’ (1 Bit) Low 0/0/1
LIGHTING.DIMMER.1/1/11 CHANNEL.B.RelDIM EIS 2 ‘Dimming - control’ (4 Bit) Low
LIGHTING.DIMMER.1/1/12 CHANNEL.B.VALUE EIS 6 ‘Scaling - percent’ (8 Bit) Low 0/0/2
LIGHTING.DIMMER.1/1/13 CHANNEL.B.STATUS.ON/OFF EIS 1 ‘Switching’ (1 Bit) Low
LIGHTING.DIMMER.1/1/14 CHANNEL.B.STATUS.VALUE EIS 6 ‘Scaling - percent’ (8 Bit) Low
LIGHTING.DIMMER.1/1/20 CHANNEL.C.ON/OFF EIS 1 ‘switching’ (1 Bit) Low 0/0/1
LIGHTING.DIMMER.1/1/21 CHANNEL.C.RelDIM EIS 2 ‘Dimming - control’ (4 Bit) Low
LIGHTING.DIMMER.1/1/22 CHANNEL.C.VALUE EIS 6 ‘Scaling - percent’ (8 Bit) Low 0/0/2
LIGHTING.DIMMER.1/1/23 CHANNEL.C.STATUS.ON/OFF EIS 1 ‘Switching’ (1 Bit) Low
LIGHTING.DIMMER.1/1/24 CHANNEL.C.STATUS.VALUE EIS 6 ‘Scaling - percent’ (8 Bit) Low
LIGHTING.DIMMER.1/1/30 CHANNEL.D.ON/OFF EIS 1 ‘switching’ (1 Bit) Low 0/0/1
LIGHTING.DIMMER.1/1/31 CHANNEL.D.RelDIM EIS 2 ‘Dimming - control’ (4 Bit) Low
LIGHTING.DIMMER.1/1/32 CHANNEL.D.VALUE EIS 6 ‘Scaling - percent’ (8 Bit) Low 0/0/2
LIGHTING.DIMMER.1/1/33 CHANNEL.D.STATUS.ON/OFF EIS 1 ‘Switching’ (1 Bit) Low
LIGHTING.DIMMER.1/1/34 CHANNEL.D.STATUS.VALUE EIS 6 ‘Scaling - percent’ (8 Bit) Low

Adding the KNX Control Gateway

1.  Click ADD NEW... under the Control Gateways sidebar button and select the Building
automation icon.

Building automation

2. Type the name of the control in the Name field.
3. Select the device from the Manufacturer drop-down list.

4.  Select the model from the Model drop-down list.
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5.  Click the Next button to go to the Control tab.

6. Enter the bus address in the Physical Address field. The IP address can also be

entered in the IP field.
Physical Address

Ping
If the IP address is found, then the Ping button will display “Ping
OK”. If not, then “Ping Error” will be displayed.

7.  After entering the required information, click the Next button in the lower-right corner
of the screen to continue to the Elements tab.
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Adding Elements

1. Under the Elements tab, click the Upload a file button.

2. Locate the .esf file on the computer (e.g. knx.esf).

Upln@d a file

3. Select the .esf file from the File Upload dialog and click the Open button.

Once the . esf file has been imported, the filename will appear next to the
Upload a file button.

4. Click ADD NEW... to add an element from the programmed device list to the GAVA
Wizard menu. Add all of the elements that will be used in the system here.
Elements will be assigned to specific rooms later in the Rooms menu.

Import ESF File Upload a file

(+) ADDNEW...
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Adding Elements >>

1.  Select Dimmer from the Type drop-down list.
2. Provide a name for this control in the Name field.

3. Select the Status SET state from the drop-down list. This setting is used for
dedicated ON and OFF switching when using the buttons left and right from the slider.

4. Select the Status GET state from the drop-down list. This setting is used for
dedicated ON and OFF feedback. If no feedback is available, then the GET value
will be the same as the SET value.

5.  Select the Value SET state from the drop-down list. This setting is used for dedicated
value dimming when using the slider control, itself.

6. Select the Value GET state from the drop-down list. This setting is used for dedicated
dimmer value feedback. If no feedback is available, then the GET value is the same
as the SET value.

7.  After all the necessary information has been added, click the Save button.
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SPECIFICATIONS

Ethernet POrt.... ..o (1) RJ-45
USB POIES. ...ttt (2) Type B
RS-232 PON.... ettt (1) DB-9, male
POWET SUPPIY...c.eetieiit ettt 12V /1.2ADC
Power ConsSUMPLION. .......c.oiiiiiiiiii e 2.5W (idle) / 25W (max.)
Dimensions (W X H X D)..ccooviiiiiiiiiiiiiceee 4.2"x6.4”x 1.2 (107mm x 163mm x 30mm)
ShIpPING WEIGNT......coiiiiiii e 4 bs (1.8 kg)

146



WARRANTY

Gefen warrants the equipment it manufactures to be free from defects in material and
workmanship.

If equipment fails because of such defects and Gefen is notified within two (2) years from
the date of shipment, Gefen will, at its option, repair or replace the equipment, provided
that the equipment has not been subjected to mechanical, electrical, or other abuse or
modifications. Equipment that fails under conditions other than those covered will be
repaired at the current price of parts and labor in effect at the time of repair. Such repairs
are warranted for ninety (90) days from the day of reshipment to the Buyer.

This warranty is in lieu of all other warranties expressed or implied, including without
limitation, any implied warranty or merchantability or fitness for any particular purpose, all of
which are expressly disclaimed.

1. Proof of sale may be required in order to claim warranty.
2. Customers outside the US are responsible for shipping charges to and from Gefen.
3. Copper cables are limited to a 30 day warranty and cables must be in their original

condition.

The information in this manual has been carefully checked and is believed to be accurate.
However, Gefen assumes no responsibility for any inaccuracies that may be contained

in this manual. In no event will Gefen be liable for direct, indirect, special, incidental, or
consequential damages resulting from any defect or omission in this manual, even if
advised of the possibility of such damages. The technical information contained herein
regarding the features and specifications is subject to change without notice.

For the latest warranty coverage information, refer to the Warranty and Return Policy under
the Support section of the Gefen Web site at www.gefen.com.

PRODUCT REGISTRATION

Please register your product online by visiting the Register Product page under the
Support section of the Gefen Web site.
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